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Installation, configuration, and first launch 

The installation, initial configuration and activation of the plugin is  described 
in the Quick Setup Guide, which is also included with the installation package. 

https://www.dehancer.com/help/installation_setup
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GPU render selection [Pr] 

In Adobe Premiere, you need to select the correct GPU engine when you create 
the  New  Project to make rendering and preview run at high performance. 
Otherwise, the system will automatically switch to software renderer, 
making performance extremely poor. 

Notice that this setting can only be changed when creating the project. 

In the New Project window go to: 
General → Video Rendering and Playback →  Renderer 

Windows 
Select your GPU engine depending on the plugin distributive you used 
for the installation – CUDA or OpenCL. 

macOS 
Select the Metal rendering engine. 
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Color Settings [Ae, Pr] 

Correct colour settings for your Project / Sequence are important, as Dehancer 
can handle a specific set of colour spaces and gammas at Input. 

Although Premiere Pro and After Effects do not offer such a wide range of color 
pipelines, please check these settings: 

Project Settings [Ae] 

1. Open After Effects menu, File → Project Settings… 

2. Select  Depth: 16 bits per channel to get better gradations 
and less artifacts. 

3. Select Assume Working Gamma: 2.4 (Rec. 709) as the standard 
for SDR grading. 
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Sequence Settings [Pr] 

1. Open Premiere Pro menu, Sequence → Sequence Settings… 

2. Select Video / Working Color Space: Rec. 709 as this is the basic standard 
for SDR grading using Dehancer. 

3. How to get better rendering and preview quality in Premiere Pro 
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Dehancer Input Settings 

Usually, Dehancer Input should match your Project / Sequence color space 
and gamma. 

In the Ae/Pr workflow, it would be either the Rec. 709 (normal contrast source) 
or the Choose Camera (Log footage).  

Source interpretation is covered deeper in this chapter: 
Input Source, Camera Profiles. 
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Performance tips and realtime playback 

Dehancer is a complex software with sophisticated algorithms.  
We are constantly improving the performance, but the high-quality 
film simulation still requires top hardware to run smooth.  

We cannot fully guarantee realtime playback because it depends on many 
factors, including hardware, operating system, video drivers, host application 
version, plugin version, FX chain and video dimensions. However, there are 
options to improve the Preview performance up to the realtime experience. 

Common tips: 

1. Turn off some GPU-critical Dehancer tools at different stages of color 
grading. For  example, Grain and Halation may be enabled at the final stage 
of video processing, since they consume a lot of processing power. 

2. Turn off other consuming FX in the chain, like noise reduction. 

3. Convert the original video to a format that is easier to decode, for example, 
DNxHR or Apple ProRes, which is processed with a dedicated hardware codec 
on modern Apple computers and creates almost no additional processing load. 

4. Apply Dehancer to the Adjustment Layer or Nested Sequence, 
instead  of  individual clips. In  the  latter case, multiple plugin instances 
are loaded, each of them consuming additional resources. 

5. Close unnecessary applications that may consume memory and actively use 
the processor in the background. 

[Ae] 

1. Disable Frame Blending and Motion Blur 
in the Composition settings. 

2. In the Project Settings disable Depth: 16 bits 
per channel. Notice that video quality may 
suffer with this setting. 

3. Set the Preview Resolution to Half and lower. 

4. Pre-render your Composition containing heavy 
VFX and composing before applying Dehancer. 
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[Pr] 

1. Disable the Maximum Bit Depth and the Maximum Render Quality 
checkboxes in the Sequence Settings. Notice that video quality may suffer with 
this setting. 

2. Set the Playback Resolution of the video preview to 1/2 and lower. 

Also it is convenient to set the Paused Resolution to Full, while keeping 
the Playback Resolution lowered. 

Dehancer plugin settings 

While Film profiles and Print tools don’t stress the hardware, other Dehancer FX, 
like Film Grain and Halation, require lots of processing power to run in realtime. 

Then, as said, it is logical to temporary disable heavy Dehancer tools if you need 
realtime. 

Also you can set the Film Grain → Mode to Digital (exp.) for non-critical or low 
resolution output. This is a simplified grain generator that speeds-up 
the playback. 
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Preview and Rendering quality settings [Pr] 

When using Dehancer and other plugins with Adobe Premiere Pro, the Preview 
and the rendered footage may suffer from posterisation artifacts. 
This is caused by insufficient bit depth. 

Maximum Preview quality: 

1. In the Premiere menu select Sequence → Sequence Settings. 
2. In the Video Previews section enable the Maximum Bit Depth checkbox. 
3. Optionally you can enable the Maximum Render Quality checkbox. 
4. Then you will get the warning alert, which in most cases can be ignored. 
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Maximum Render quality: 

1. Go to the Export tab. 
2. In the Video / Basic Video Settings enable the Render at Maximum Depth 
checkbox. 
3. Optionally you can enable the Use Maximum Render Quality checkbox. 

 

Note: These settings may significantly affect the plugin performance 
and memory requirements. 
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Adding Dehancer to the Project [Ae] 

1. After the plugin installation, restart After Effects if it was already running. 

2. Open a Project. 

3. Open the Effects & Presets panel (or press Cmd + 5). 

4. In the Effects & Presets tab, open the Film Emulation group and find 
Dehancer. 

5. Select a clip on the timeline, then drag and drop Dehancer to  the clip. 
Also, you can double-click the effect to apply it to the selected clip. 

Tip: 
In the same way, Dehancer can be applied not only to the individual clips, 
but  also to the  Adjustment Layers, thus allowing to grade the entire 
timeline with a single Dehancer instance. 
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Adding Dehancer to the Project [Pr] 

1. After the plugin installation, restart Premiere Pro if it was already running. 

2. Open a Project. 

3. Open the Effects panel (or press Shift + 7). 

4. In the Effects tab, open the Video Effects / Film Emulation group and find 
Dehancer. 

5. Select a clip on the timeline, then drag and drop Dehancer to  the clip. 
Also, you can double-click the effect to apply it to the selected clip. 

Tip: 
In the same way, Dehancer can be applied not only to the individual clips, 
but  also to the  Adjustment Layers, thus allowing to grade the entire 
timeline with a single Dehancer instance. 
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Applying Dehancer to multiple clips at once 

There are several methods to add Dehancer to multiple clips at once, and there 
is also a Copy/Paste functionality for effects, + custom presets. 

Copy and Paste the effect [Ae, Pr] 

You can configure Dehancer on a single clip, then copy and paste the effect to 
the rest of your sequence.  

Use the Copy and Paste context menu in the Effect Controls panel. 

 
Copy and Paste Clip Attributes [Pr] 

1. Select a clip. 

2. Use the Copy and Paste context menu to copy the clip and its attributes. 
Also you can press Cmd + C (Ctrl + C) 
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3. Select another clip(s). 

4. Select Paste Attributes in the context menu or press  Option  +  Cmd  +  V 
(Alt + Ctrl + V). 

Tip: 
Don’t forget to revise Dehancer settings to compensate for possible 
difference between the clips. 
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Adjustment Layer [Ae] 

1. In the After Effects menu select Layer → New → Adjustment Layer. 

2. Set the length of the Adjustment Layer to match your Composition. 

3. Apply Dehancer to the Adjustment Layer, as if it were an ordinary Layer 
or Clip. All the Layers below will be affected. 

 
Adjustment Layer [Pr] 

1. Select the Project panel. 

2. In the Premiere Pro menu select File → New → Adjustment Layer. 

3. Drag and drop the Adjustment Layer from the Project panel to the 
Timeline, just above the clips that should be impacted. 

4. Adjust the length of the Adjustment Layer to match your video. 

5. Apply Dehancer to the Adjustment Layer, as if it were an ordinary video 
footage. All the clips below will be affected. 
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Nested Sequence [Pr] 

1. Select multiple clips on the timeline. 

2. In the clip right mouse button menu select Nest… and confirm. 

3. All clips will be combined in a single Nested Sequence. 

4. Apply Dehancer or any other correction or FX to this new clip, 
as if it were an ordinary video footage. All clips inside will be affected. 

Effect Presets [Pr] 

Premiere Pro lets you save current FX parameters as a Preset, which can be 
applied to any clip within the current or any other project. 

1. Right click on the Dehancer FX in Effect Controls panel 

2. Select Save Preset… 

3. New Preset will appear in the Effects panel → Presets folder. 
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Dehancer plugin in the FX chain 

Normally Dehancer plugin should be placed in the end of  the  processing 
sequence, e.g., at the bottom of the effects stack.  

Other additional correction (Lumetri Color, Color  Wheels, Levels, Curves,  etc) 
can be added before Dehancer. 

Some specific effects not related to color correction may be placed 
after Dehancer (for example, mastering Sharpen). 

To better understand the workflow integration principles treat Dehancer 
as a virtual film on which you are shooting an already prepared and properly lit 
scene. This makes it easier to figure out why all basic corrections and masks 
should be applied before Dehancer or in the Input section of the plugin. 

Typical effects sequence: 

(Lumetri Color) → Primary Corrections → Composing → Dehancer  → (Sharpen)  

Tip 1: Apply Dehancer as an Adjustment Layer to get complete 
and  seamless film look if you are using transitions, titles, composing 
and VFX. 
 
Tip 2: If your source requires noise reduction or any other heavy 
preprocessing, we  recommend to perform it prior to the grading stage, 
then render your clip to ProRes and use this clip as a new source. 
Thus you will significantly reduce the computational load, allowing you 
to use Dehancer with better preview performance. 
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Input source, camera profiles 

If your source clip has been shot in Rec.709 color space, it already has 
the  ‘normal’ contrast and do not require any transformation. It’s just enough 
to select the Rec.709 option in the Source settings of the plugin. 

However, professional production is usually based upon shooting in different 
types of Log Gamma, which gives you a greater dynamic range and  more 
flexibility in postprocessing but requires a thoughtful interpretation. 

There are several ways to do the Log to Rec.709 transformation: 

- Input camera profiles in Dehancer 
- Built-in LUTs in Lumetri Color 
- Camera vendor and custom LUTs 
- Manual de-Log with color correction tools 
- Third-party plugins for camera matching (Film Convert, etc.) 

Each method has its own benefits and drawbacks. You can choose and adjust 
your interpretation, according to  the  characteristics of the particular clip 
or movie concept. 

The proper Dehancer Input settings are crucial for both the source 
interpretation and the timeline integration of the plugin. 

Source 

The Source parameter should either match your project/sequence color space 
or a particular clip: 

Clips with normal contrast (including HLG, all kinds of ‘Flat’ profiles, etc.) 
 
Select the Rec.709 Input option. 

Clips with Log gamma 
 
Option 1: De-Log with any convenient tools (Lumetri Color, factory and 
custom LUTs, manual correction) and select the Rec.709 Input option 
in Dehancer. 
 
Option 2: Use the Dehancer built-in camera profiles (as described below). 
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Choose Camera 

The Choose Camera option allows you to select from the range of high quality 
custom camera profiles built by the Dehancer team. 

Dehancer camera profiles can only be applied correctly if all of the following 
conditions are met: 

1. The source clip has been captured in Log format. 

2. Project / Sequence is set to Rec. 709. 

3. All other color conversions are turned off in the processing chain before 
Dehancer. 

Notice: 
Camera profiles are custom made to meet our high aesthetic standards 
instead of just technically matching. Therefore, our profiles may and will 
differ from the factory-made or built-in LUTs and camera profiles. 

Working with HLG and normal contrast source 

Many cameras allow shooting in HLG, ‘Flat’ and various creative modes 
(for example, Sony Cinetone). 

Camera profiles in Dehancer are designed to interpret low contrast Log video. 
Clips with normal contrast (HLG, Flat, Cinetone, etc.) do not need gamma curve 
interpretation and can be used as is, while  Rec.709 should be selected 
in the Input of the plugin. 

In this case, the Film Developer tool can be used to better adapt the video 
if it significantly falls out of the Rec.709 standards. 

Related articles: 

How to manage image contrast and avoid clipping 
Complete list of Dehancer camera profiles

→

https://blog.dehancer.com/articles/how-to-manage-image-contrast-and-avoid-clipping/
https://www.dehancer.com/profiles
https://blog.dehancer.com/articles/how-to-manage-image-contrast-and-avoid-clipping/
https://www.dehancer.com/profiles
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Tool Profiles 

Several Dehancer tools have a drop-down list of Tool Profiles that makes them 
much easier and simpler to use. 

Tool Profiles are the sets of pre-configured parameters designed to recreate 
the typical look of 8 mm, 16 mm, 35 mm and 65 mm films. 

You will find more specific information on Tool Profiles in the dedicated tool 
specifications in this manual: 

 Film Grain 
 Halation * 
 Bloom 
 Film Damage * 
 Film Breath * 
 Gate Weave * 

* Featured in Dehancer Pro 

Tip: In order to change the parameters of any profile, you must first select 
the most suitable one and then switch to Custom mode. All the usual 
effect settings will be available to you, and the parameter values will match 
the last selected profile. 

 

Related article: 

Dehancer Tool Profiles
→

https://blog.dehancer.com/articles/dehancer-tool-profiles/
https://blog.dehancer.com/articles/dehancer-tool-profiles/
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Input corrections 

Input corrections are meant to quickly compensate for obvious technical issues 
of a source material. 

Exposure Comp. 

This setting can be used to compensate for the exposure errors of the source 
media. 

Unlike the Exposure setting in Print tool, this is a technical correction 
of  the  original image before any Dehancer effects are applied. Conversely, 
Print Exposure is rather a creative setting, the results of which largely depend on 
the selected profile, print media, and other settings within the plugin. 

Exposure Compensation is technically applied with the source color conversion. 
Therefore  it may produce better results than adjusting exposure with 
conventional tools. The  only  exception is RAW video, for which it is better 
to apply exposure compensation in the corresponding RAW plugin (if available). 

Temperature Comp., Tint Comp. 

These settings technically work in a similar manner but  in  relation 
to the temperature and tint of the source. 

Defringe 

Defringe helps to deal with the chromatic aberrations visible at the edges 
that  may interfere with some of the Dehancer effects, such as Halation 
and  Bloom. In  Dehancer Pro, Defringe settings are  located in  the Input 
parameters group. In  the Dehancer Halation plugin, they  are  located 
in a dedicated group. 

Tip 1: Temperature and Tint compensation are better suited for strong 
deviations of  a source, while Color Head is designed mostly for  creative 
application and more subtle adjustments. 
 
Tip 2: In some particular cases Defringe may lead to visible halos around 
the edges in combination with the Bloom or Halation effects. Lowering 
 the Defringe amount and radius settings helps to deal with this issue. 
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Film Profiles, Push/Pull 

Film Profiles are heart and soul of Dehancer. Each film is accurately sampled 
with all of its characteristics. If you are ready to bet on years of film experience – 
then you can simply scroll and try film profiles in the list until you get the most 
interesting or desired results. 

Push/Pull (Ev) 

All films behave differently depending on how much light they received during 
exposure. In Dehancer film exposure is implemented with the Push/Pull (Ev) 
parameter. In  fact  there are 3 different film exposures sampled to build each 
film profile in Dehancer. 

As a creative tool Push/Pull allows you to vary color-contrast look of a scene 
within a selected film profile. Also, Push/Pull can be a good helper in clipping 
control, since contrast greatly depends on film exposure. With negative films it 
affects overall color and contrast. With positive films Push/Pull allows to set the 
desired slide exposure, opening blocked shadows or protecting blown-out 
highlights. 

Film color temperature and source white balance 

When creating film profiles, we illuminate the color target using the light source 
with the color temperature for which a particular film is intended 
by  the  manufacturer. Thus, Daylight films are shot under the reference light 
source with a temperature of about 5300K, while Tungsten emulsions require 
3200K incandescent bulbs. Therefore, we get the neutral color reproduction 
with minimal deviations in white balance at the shooting stage. 

When printing the negative optically, we additionally correct the white balance 
using color filters in the enlarger, bringing the neutrals to the reference value 
with great accuracy. 

This means that technically any film profile is designed for source material 
with neutral white balance. 

Remember that you can use the Temperature Comp. and Tint Comp. settings 
in the Input section to additionally compensate for the source white balance. 
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Tip 1: We optically print negative B&W films on the famous 
Slavich  Bromportrait paper known for its noble warm tone. If you need 
a  pure black and white look, you may set the Saturation = 0 
in the Print section at any time. Also you can try CMY Color Head and Print 
Toning parameters to adjust tint and split-toning at your taste. 

Tip 2: There is no dedicated Opacity control for Film Profile by technical 
reasons but mostly by design – one cannot shoot on film ‘halfway’. 
However you can apply two Dehancer FX instances or Adjustment layers – 
first with the Input and Film Profile enabled, second with Expand, Print, 
Grain, and other FX. It’s rather flexible as you can set the desired ‘film 
opacity’ with Total Impact slider, available in common plugin controls. 

 

Related articles: 

How we build film profiles 
What is Push/Pull and how it works? 
Modern motion picture color negative films 
Complete list of Dehancer film profiles

→

https://blog.dehancer.com/articles/how-we-build-film-profiles/
https://blog.dehancer.com/articles/what-is-push-pull-and-how-it-works/
https://blog.dehancer.com/articles/modern-motion-picture-color-negative-films/
https://www.dehancer.com/profiles
https://blog.dehancer.com/articles/how-we-build-film-profiles/
https://blog.dehancer.com/articles/what-is-push-pull-and-how-it-works/
https://blog.dehancer.com/articles/modern-motion-picture-color-negative-films/
https://www.dehancer.com/profiles
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Film Developer 

Featured in: Dehancer Pro 

The conventional analogue approach makes it possible to process film 
by  individually configuring the formula of the developer solution 
and  the development process. Film Developer tool allows to make your own 
development recipe depending on the source material, shooting conditions and 
creative tasks. 

Contrast Boost 

This parameter controls the developer contrast. In analogue processes, 
development contrast is determined by developer temperature 
and  concentration. In Dehancer this parameter can take both positive values 
(contrast increases) and negative values (contrast decreases). 

Gamma Correction 

In film processing gamma correction controls the contrast ratio of a negative, 
in  relation to the exposure time. This parameter determines how much 
the  midtones are shifted towards shadows or highlights. Gamma correction 
is possible with any Contrast Boost value other than zero. 

Color Separation 

The color separation of the negative film is determined by the color filters in the 
emulsion layers, the sensitisation of each layer and their order. In Dehancer 
you  can control the ‘chemical component’ of the developer, which affects 
the sensitisation of the emulsion layers. 

When Color Separation value is reduced, saturation of the most intense colors 
is  reduced first, while medium and low saturation colors remain almost 
unaffected. 

By default, the Color Separation setting has a maximum value of +100. It affects 
the image at any Contrast Boost value other than zero. 
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Color Boost 

Some color development processes allow saturation to be controlled 
by  the  properties of the dyes that are introduced into the emulsion 
at  the  development stage. In Dehancer, this feature is implemented 
in  the  Color  Boost parameter, which increases or decreases the overall 
saturation of the image (not only the most saturated colors, as with 
Color Separation). This type of color enhancement is gentle and does not lead to 
clipping, i.e. all colors remain inside the color gamut. 

Practical tasks that can be solved with Film Developer: 
 
- Grading a source with an unknown gamma, contrast and color, 
for example, a Flat or Log video footage from an unknown camera. 
 
- Working with a non-standardised videos, for example, the D-Cinelike that 
looks different on different DJI drones, depending on the specific camera 
and exposure conditions. 
 
- Dealing with a camera that doesn’t have a dedicated profile in Dehancer. 
 
- Making additional adjustments to the interpretation of the source 
material. 
 
- Adjusting the excessive or insufficient contrast, which you want 
to normalise and make more flexible for further processing. 
 
- Increasing the overall saturation, while avoiding oversaturation and color 
clipping where possible. 

 

Related article: 

Film Developer – a new Dehancer tool
→

https://blog.dehancer.com/articles/film-developer-a-new-dehancer-tool/
https://blog.dehancer.com/articles/film-developer-a-new-dehancer-tool/
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Film Compression 

Featured in: Dehancer Pro 

Usually on a negative film, clipping in  the  highlights occurs much later than 
on a digital camera. 

To  emulate the  film-like compressed tonal range, we  invented 
the  Film  Compression tool. It lets you fine-tune the  redistribution 
of the highlights. The resulting image looks more analogue and becomes more 
flexible for further manipulation with exposure, contrast, film/print profiles, etc. 

Impact 

This parameter determines the degree of compression. The higher the Impact 
value, the more the highlights are pushed towards the midtones. 

White Point 

The White Point parameter defines the  ‘film clipping threshold’, and directly 
affects contrast because it  determines the  steepness of  the  transition 
to  the clipping area. As  the white point gets closer to  the midtones, the more 
contrast the image appears. 

By default, White Point = 100. This means that it stays at its initial position. 

The  White Point can be lowered, thereby increasing the  overall contrast 
of  the  compressed range. The minimum possible value is  50. The lower 
the White Point is, the more likely clipping will occur in the highlights. 

Alternatively, the white point value can be  increased. In  this  case, the overall 
contrast of  the  compressed range is  reduced. The  maximum possible value 
is 120. The higher the White Point  is, the more flat and grayed the highlights 
appear. 

Tonal Range 

This parameter represents the  width of  the  tonal  range affected by 
Film  Compression tool. A  minimum value  =  0 means no  compression. 
A maximum value = 100 means that the  compression affects the wide range 
from the brightest highlights almost all the way down to the deepest shadows. 
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Color Density 

Different films reproduce color differently as  they get closer to  the highlights. 
Negative  films tend to  noticeably loose saturation in  the  highlights. 
Slides remain more vibrant, even though the clipping occurs earlier. 

The Color  Density parameter controls the  color intensity of  the  compressed 
range. Color  Density  =  0 produces the  lowest saturation in  the  highlights, 
which is more typical for negative films. Color Density = 100 provides maximum 
saturation, and the image looks more like positive films. 

Tip: Although the Film Compression tool is not designed to restore 
highlights lost in the source file, you can still use it effectively to make 
the highlights more textured and smooth out the clipping. 

 

Related article: 

Film Compression — new Dehancer tool
→

https://blog.dehancer.com/articles/film-compression-new-dehancer-tool/
https://blog.dehancer.com/articles/film-compression-new-dehancer-tool/
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Expand 

Expand tool provides a separate manual control for black and white points 
in relation to the output color space. 

All films naturally have different contrast, different black and white points. 
At  the  sampling stage, we avoid digital correction to preserve the individual 
features of the films, which  ensures a fair and convincing simulation. 
Thus,  film  profiles in Dehancer, without  additional adjustment, usually lack 
contrast, but at the same time they  have a lot of headroom for creative 
adjustments. 

We recommend adjusting Expand immediately after a film profile 
selection. Set the black and white points to ‘fit’ an image into a dynamic 
range of your timeline color space. Clipping control is  essential 
at this point, so keep an eye on the Waveform.  
 
During a grading session you will probably revisit this tool several times. 

Color Mode 

The Color Mode option can be useful if you encounter unwanted color shift 
or  oversaturation. In the Luma mode Expand affects only the luminance 
component of an image, but does not affect its color, so the changes in contrast 
have no effect on the saturation. 

Tip: If your source doesn’t have enough headroom for the Expand 
adjustments try  to  enable the Analogue  Range  Limiter checkbox 
in the Print toolset which gives more ‘relaxed’ extremes. 

Also you can use the Film Compression tool to make the highlights more 
textured and smooth out the clipping. 

 

Related article: 

How to manage image contrast and avoid clipping
→

https://blog.dehancer.com/articles/how-to-manage-image-contrast-and-avoid-clipping/
https://blog.dehancer.com/articles/how-to-manage-image-contrast-and-avoid-clipping/
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Print Medium Selection 

Featured in: Dehancer Pro 

Note that the Dehancer Light plugin does not have an option for print 
media selection. In this plugin, films are always ‘printed’ on Kodak Endura 
Glossy Paper. 

 
Optical printing is the last stage of the analogue production. As the result we get 
a paper print for direct viewing or a positive film for screen projection. Both can 
be scanned for digital delivery. Optical printing is the only analogue solution that 
can be used for proper interpretation of the negative films. 

Beyond the technical significance, any print medium has its own tint, photo 
latitude and contrast curve that makes it a useful creative tool.  

In the Print parameters group, you have a choice of the print mediums: 

Linear 

Only a ‘pure’ profile of a selected film is used, without the influence 
of the characteristics of photographic paper. 

Cineon Film Log 

Selected film is ‘printed’ into Cineon film scan format. This parameter also 
makes it possible to ‘print-out’ negatives outside Dehancer. 

Kodak 2383 Print Film, Fujifilm 3513 Print Film 

Selected film is ‘printed’ onto Kodak Vision Color Print Film 2383 or 
Fujicolor Positive Film Eterna-CP 3513DI. 

Kodak Endura Glossy Paper 

Selected film is ‘printed’ onto Kodak Endura Premier Glossy Paper. 
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Tip: It is convenient to follow the analogue pipeline when matching 
the print medium with the film. Use the Linear profile with positive films, 
Kodak 2383 or Fujifilm 3513 for corresponding movie stocks and Kodak 
Endura paper for photographic negative films. However, experiments are 
always welcome. 

Print Settings 

Relying on our experience in optical printing and our research 
into  the  psychophysiology, we have developed the dedicated print settings 
that faithfully reproduce the analog processes: 

Target White 

Only available when Kodak 2383 Print Film or Fujifilm 3513 Print Film 
is selected. Allows to adjust the temperature of the printing light source in the 
5500-6500 K range. 

Exposure (Ev) 

The Exposure tool is based on characteristic curves of optical prints. 
With  the  analogue approach to the exposure correction it naturally affects 
the  image contrast too. This  parameter is measured in the exposure value 
steps (Ev). 

Tonal Contrast 

The Tonal Contrast tool inherits a nonlinear nature of analogue processes. 
Increase  the value to give more punch or apply negative correction to visually 
‘soften’ an  image. Notice that changing the contrast also visually affects 
the exposure, which is also typical for analogue media. 

Color Density 

Traditional ‘digital’ saturation affects all hues equally and linearly. 
On  the contrary, the Color Density tool provides perceptual saturation control, 
i.e. it affects aesthetically significant colors in a higher degree. 
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Color Density can be used to quickly solve many specific problems – 
for example, to mitigate oversaturated accents or emphasise meaningful colors 
without painstaking adjustment. 
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Saturation 

This is a more "traditional" saturation control based on altering the chroma 
components in YCrCb space. This correction is available only in the reduction 
way due to the fact that oversaturation usually degrades the aesthetics. 

Analogue Range Limiter 

By default, Print adjustments work within the boundaries of the ‘digital’ contrast 
range. Black  and white points are normalised to the digital brightness values 
of 0 and 100, respectively. 

To obtain a softer image and improve the detail at the extremes of the tonal 
range, enable the Analogue Range Limiter which uses the uncorrected black 
and white point values as they were measured on the reference prints. 

Tip 1: Even though Tonal Contrast uses sophisticated nonlinear 
compression, it may lead to some clipping at high values. If this happens, 
revisit Expand to  set  a  more ‘relaxed’ cutoff for black and white points 
or  enable the  Analogue  Range Limiter checkbox to get more headroom 
for  processing. Also you can use the Film Compression tool to make 
the highlights more textured and smooth out the clipping. 
 
Tip 2: To get a saturated and expressive image, we recommend starting 
with  increasing the contrast and simultaneously slightly decreasing 
the  exposure. You can also adjust the Color Density to emphasise 
your colors. 
 
Tip 3: Some combinations of the print settings may produce colors falling 
out of the gamut, with visible artefacts, especially when Color Density 
is  increased. In this case lower the contrast and saturation or try another 
film or print media profile. 

 

Related article: 

How to manage image contrast and avoid clipping
→

https://blog.dehancer.com/articles/how-to-manage-image-contrast-and-avoid-clipping/
https://blog.dehancer.com/articles/how-to-manage-image-contrast-and-avoid-clipping/
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CMY Color Head and Print Toning 

Subtractive CMY Color Head is based upon the analogue color correction tool 
integrated in  photo enlargers. The similar method is used in Printer Lights – 
a special device for optical movie printing to a positive film. Both have the same 
principle – changing the color of light used for print exposure.  

In Dehancer the Color Head tool is represented with three complementary color 
pairs (YMC-BGR or commonly used CMY-RGB), combining both analogue 
devices into one digital tool: 

Yellow — Blue 
Magenta — Green 
Cyan — Red 

The effect of changing these parameters corresponds respectively 
to their labels. 

Gang 

Dehancer uses the real-life measured color filters values. Thus, even with 
the identical adjustments in all three axis, the color changes are visible. For your 
convenience, we  have  provided the Gang checkbox, which allows changing 
all three filters at once. 

Shadows Tone 
Midtones Tone 
Highlights Tone 

In a general analogue sense, toning refers to giving a paper print or film positive 
additional tints that  are not originally characteristic of a particular media 
combination. This technique is widely used in movie production to give a special 
character or atmosphere when the original film properties are insufficient. 

Unlike the digital world, where you can ‘fill’ the entire picture with a single hue, 
analog media is more varied. In addition to the natural variations across 
the  tonal range, a  print can be intentionally colored with  different 
tints in the shadows, midtones, or highlights. 
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Toning can be achieved using a variety of methods, including special exposure 
and processing mode, additional treatment with various chemicals, and split 
printing through color filters with masking. 

In Dehancer, the toning control is a natural evolution of the CMY Color Head tool. 
Therefore, it’s based on split printing through color filters, with the only 
difference that masking is performed automatically. 

You can control the color temperature separately within three equally quantised 
ranges – in shadows, midtones, and highlights. 

Preserve Exposure 

During the analogue printing the exposure is affected by color filters. 
Dehancer  inherits this behaviour. When Preserve Exposure is set to 100%, 
it  automatically compensates any  exposure changes, introduced 
by the Color Head corrections. 

Impact 

This slider adjusts an overall impact of the effect, acting like ‘opacity’. 

Tip 1: Prefer the Color Head tool for creative adjustments, while leaving 
the  Input  Temperature and Tint compensation for strong WB deviations 
of a source material. 
 
Tip 2: Setting the Preserve Exposure slider to zero results in exposure 
changes during color correction – just the way it does with the analogue 
printing process. This is an additional way to naturally change an image 
density in Dehancer. 

 

Related article: 

CMY Color Head – analogue correction for digital images
→

https://blog.dehancer.com/articles/color-head/
https://blog.dehancer.com/articles/color-head/
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Film Grain 

Real grain on film isn’t just overlaid on top of an image, but in fact the image 
itself entirely consists of  grain. Dehancer literally reconstructs the shot, using 
the local color and  brightness characteristics along with a complex physical 
modelling of a film emulsion. 

Grain Profiles 

We’ve created grain profiles for 8, 16, 35 and 65 mm, each in three versions: 
ISO 50, 250 and 500. 

In order to change the parameters of any profile, you must first select the most 
suitable one and then switch to Custom mode. All the usual effect settings 
will be available to you, and the parameter values will match the last selected 
profile. 

Custom settings 

The Custom settings allow you to configure Film Grain as you like. 

There are 2 film types and 2 processing modes available in Dehancer: 

Film Type 

1. Negative grain is more pronounced in the highlights and the image 
has a slightly higher microcontrast, which is more typical for negative films. 

2. Positive grain uses the ‘classic’ algorithm that reproduces a softer grain, 
which is less pronounced in the highlights and is more typical for positive 
films. 

Processing Mode 

1. Analogue is the original type of grain that requires more processing power 
but results in lifelike simulation. 

2. Noise is the high performance simplified grain that may be useful 
for dithering tasks (for example, to eliminate the posterisation), for low-
resolution projects and draft or dailies rendering. 



38

Size 

This parameter determines a size of silver halide granules. A higher Size value 
corresponds to a more photosensitive (and therefore more granular) emulsion. 

Amount 

Total amount of grain generated, corresponding to a ‘film’ optical density. 

Shadows, Midtones, Highlights 

This parameter affects grain distribution between different zones of a tonal 
range to match your scene texture and grading look by setting the grain amount 
individually for shadows, midtones and highlights. 

Film Resolution 

Usually the smallest image detail on film does not exceed the grain size. 
Dehancer  Film  Grain is considering this fact by design. Also it is possible 
to  manually adjust this effect to mimic a specific emulsion resolution 
or to compensate for an excessive image softness. 

Film Resolution parameter set to 100 keeps the initial sharpness of a source 
media. Lowering the Resolution results in gradual loss of detail, while an image 
becomes more blurred.  Resolution set to 50 represents the  detail balanced 
with a current grain size and amount. 

Chroma 

Grain chromaticity may vary on different films. This parameter determines 
the saturation of the dye granules in film emulsion. 
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Tip 1: On the real film, grain can be found in both the deepest shadows 
and  the  lightest highlights. But it cannot be visible on pitch black or pure 
white – technically  there’s no  detail in  there. That is why Film Grain 
naturally affects black and white points, lowering visible contrast when 
enabled. Thus the Expand correction is recommended to regain 
the contrast. 
 
Tip 2: Sometimes, even at the minimum Size and Amount settings, grain 
appears too obvious for some applications. To get even subtler and softer 
grain lower the  Shadows, Midtones and Highlights values and  use 
the Film Resolution to make-up the excessive sharpness. Also you can try 
different grain types and processing modes. 

Related article: 

How does film grain work in Dehancer OFX plugin
→

https://blog.dehancer.com/articles/how-does-film-grain-work-in-dehancer-ofx-plugin/
https://blog.dehancer.com/articles/how-does-film-grain-work-in-dehancer-ofx-plugin/
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Halation 

Featured in: Dehancer Pro 

Halation is the film emulsion effect visible as the local red-orange halos around 
the bright light sources, specular highlights and contrasting edges. Also, halation 
may produce a  well  pronounced red glare in  the midtones, mostly affecting 
the skin tones. 

Halation Profiles 

There is 8 basic profiles with average values for the main film formats that solve 
most creative tasks and provide a convenient basis for creative adjustments. 

Each Halation simulation profile has two versions – a standard emulsion 
and  a  film of the same format, but with the anti-halation layer removed 
(No  Remjet). On films without remjet, Halation is usually excessively 
pronounced. 

In order to change the parameters of any profile, you must first select the most 
suitable one and then switch to Custom mode. All the usual effect settings 
will be available to you, and the parameter values will match the last selected 
profile. 

Custom settings 

The Custom settings allow you to configure Halation as you like: 

Source Limiter 

This setting defines the minimum light source brightness that is able to produce 
halation. The  default value = 0 means that even the weakest source is able 
to produce halation. By  increasing this value, you can cut the effect produced 
by low intensity lights. 

Background Gain 

This parameter sets the range of the background tones on which halation 
becomes visible. Default value allows halation to appear on most backgrounds. 
Decreasing this value eliminates the effect over the lighter ones. 
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Smoothness 

This integral parameter controls the distribution of the halation effect between 
the large and  small sources, visually smoothing smaller halation details. 
Increasing the Smoothness value reduces the effect around the point sources in 
favour of  the larger areas. Setting the Smoothness to zero leads to the most 
detailed halos. 

Local Diffusion 

This parameter defines how far the light spreads in an ‘emulsion’. The higher 
the Local Diffusion value, the larger the geometric size (radius) of the halos. 

Global Diffusion 

Global Diffusion controls the degree of the secondary glare produced 
by scattered light. This  is a more global effect that affects mostly low-contrast 
midtones and also enhances the primary halation. 

Amplify 

It is important not to confuse this setting with the Impact as the Amplify affects 
the  sensitivity of an ‘emulsion’ to the scattered light, not the opacity 
of  the effect. Increasing the Amplify value makes the effect more pronounced 
and shifts the halation toward yellow hues. 

Hue 

This parameter modifies the sensitivity of the green layer of an ‘emulsion’ 
to the scattered light. Use this setting to better match halation hues to a scene 
in the wide range from cool reds to warm yellows. 

Blue Comp. 

Cool backgrounds usually dampen the halation. Blue Compensation allows 
to counterbalance this effect. 
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Impact 

This parameter can be conventionally referred to as ‘opacity’, since it controls 
not  the  physical parameters of  the  emulation, but the overall transparency 
of the superimposed effect. 

Mask Mode 

This checkbox enables a special preview mode which allows you to better 
control the settings with the effect preview isolated from the source image. 

Halation + Defringe 

In some cases chromatic aberrations interfere with the Halation effect. 
Defringe tool helps to deal with this issue. 

In Dehancer Pro, Defringe settings are  located in  the  Input parameters group. 
In Dehancer Halation plugin, they are grouped in a dedicated tool. 

Halation + Bloom 

Usually these effects coexist on film and mutually influence each other. 
Therefore, it  is  generally best to use Halation and Bloom in tandem to get a 
more accurate simulation. 

Tip 1: Basic Adjustment 
Halation effect is most pronounced when Source Limiter is  at  its  lowest 
and Background Gain at its highest settings, with Amplify set to maximum. 
It  can  be a good starting point – just gradually reduce the  effect 
until getting optimal results. 
 
Tip 2: Enhance Portraiture 
Increasing the Global Diffusion can be an instant solution to  naturally 
enhance any portraiture, filling the skin tones with a  touch of vivid warm 
glare. 
 
Tip 3: Mask Mode visibility 
Mask  visibility  depends on  the  exposition and contrast of the image. 
If Halation appears too dim or invisible in Mask Mode, try  to  temporarily 
increase the Amplify and Impact values.  
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Tip 4: Simple way 
There is a simple way to fine tune these effects: 
Dial Amplify to max, adjust  limiting and details, then lower Amplify to the 
reasonable value and the Impact slider to the desirable amount. 

 

Related article: 

Halation and its simulation in Dehancer
→

https://blog.dehancer.com/articles/halation/
https://blog.dehancer.com/articles/halation/
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Bloom 

Bloom emulates the combined effect of light dispersion on the boundaries 
of  contrasting image areas, which originates in the optical system, 
and  then  amplified in the emulsion layers. Notice that bloom has little 
in common with optical soft-effects as it appears only around the light sources. 

Bloom Profiles 

To simulate the Bloom diffuse glow effect, we have created four versatile 
profiles for 8, 16, 35 and 65 mm film formats. We have selected the average 
settings, which reflect the general image character. 

In order to change the parameters of any profile, you must first select the most 
suitable one and then switch to Custom mode. All the usual effect settings 
will be available to you, and the parameter values will match the last selected 
profile. 

Custom settings 

The Custom settings allow you to configure Bloom as you like: 

Highlights 

In general, this setting may be considered the ‘sensitivity’ of the effect 
and  determines the  brightness threshold for bloom to appear. The higher 
is the value, the wider the tonal range that produces blooming is. 

Source Limiter 

Source Limiter is used to cut-off the unwanted blooming from the lower end 
of the tonal range defined by the Highlights setting. 

Details 

This setting controls the distribution of the bloom effect between large 
and  small light  sources. Increasing the value makes the effect more detailed 
and precise, up  to  the  smallest point sources. Lowering the Details results 
in a more global effect across a frame, affecting larger objects. 
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Diffusion 

Diffusion controls the extent of the bloom effect relative to the boundary where 
it  appears. The bigger is the Diffusion value, the larger is the geometric size 
of the glow radius. 

Amplify 

Amplify controls the overall effect strength by virtually ‘changing’ the brightness 
of  a  light source and the diffusion properties of an emulsion. The higher 
the value, the more obvious the whole effect becomes. 

Save Lights 

Bloom affects not only the background but also increases brightness of a  light 
source itself. In  digital pipeline this may lead to visible clipping. Save  Lights 
simply does what it’s supposed to do, protecting highlights from  possible 
clipping induced by the Bloom effect. 

Saturation 

Naturally Bloom inherits the hue and saturation of a light source. This setting 
makes it possible to desaturate the effect at your taste.. 

Impact 

This parameter can be conventionally referred to as ‘opacity’, since it controls 
not  the  physical parameters of  the  emulation, but the overall transparency 
of the superimposed effect. 

Mask Mode 

This checkbox enables a special preview mode which allows you to better 
control the settings with the effect preview isolated from a source image. 
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Tip 1: Basic Adjustment 
Bloom effect is most pronounced when Source Limiter is  at  its  lowest 
and  Highlights at its highest settings, with Amplify set to maximum. 
It  can  be a good starting point – just gradually reduce the  effect 
until getting optimal results. 
 
Tip 2: Reducing halo artifacts 
Sometimes with extreme settings Bloom may produce excessive halo-like 
artefacts. In this case try to increase the Save Lights, decrease the Amplify 
value and disable the Defringe tool. 
 
Tip 3: Mask Mode visibility 
Mask  visibility  depends on  the  exposition and contrast of the image. 
If Halation appears too dim or invisible in Mask Mode, try  to  temporarily 
increase the Amplify and Impact values. 

 

Related article: 

Bloom: what it is and how it works
→

https://blog.dehancer.com/articles/bloom-what-it-is-and-how-it-works/
https://blog.dehancer.com/articles/bloom-what-it-is-and-how-it-works/
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Film Damage 

Featured in: Dehancer Pro 

Dust, hair, scratches, stains, and emulsion irregularities damage inevitably 
appear on film. Natural ‘dirt’ enhances the impression. 

Film Damage Profiles 

We have created profiles of the most characteristic defects for the four major 
film formats. The smaller the film format, the greater the scale of the artifacts 
relative to the frame size and the more frequently they appear. 

In order to change the parameters of any profile, you must first select the most 
suitable one and then switch to Custom mode. All the usual effect settings 
will be available to you, and the parameter values will match the last selected 
profile. 

Custom settings 

The Custom settings allow you to configure Film Damage as you like. 

Film Damage tool consists of several modules, each responsible for a different 
type of artifact: 

1. Dust 

Dust Amount 

The total number of dust particles that can be present within the frame 
at the same time. 

Scale 

The parameter sets the scale of dust, i.e., the single coefficient of magnification 
for all particles. 
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Size Balance 

The Size Balance slider adjusts the ratio between artifacts of different sizes. 
At the minimum value only the smallest particles are added, at the maximum – 
the largest ones, and in the middle position – about the same amount of dust 
of different sizes. 

White-Black 

The White-Black parameter adjusts the quantitative ratio between light and dark 
artifacts. In the leftmost position only light particles will appear, in the rightmost 
position – the dark ones, and in the middle position both light and dark particles 
will appear equally. 

Dust Enabled 

The Dust Enabled checkbox turns dust on or off completely. 

2. Hairs 

Hairs Amount 

The total number of hairs that can be present within the frame at the same time. 

Scale 

The parameter sets the scale of hairs, i.e., the single coefficient of magnification 
for all particles. 

Size Balance 

The Size Balance slider adjusts the ratio between hairs of different sizes. 
At  the  minimum value only the smallest hairs are added, at the maximum – 
the  largest ones, and in the middle position – about the same amount of hairs 
of different size. 
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White-Black 

This parameter adjusts the quantitative ratio between light and dark artifacts. 

Hairs Enabled 

The Hairs Enabled checkbox turns hairs on or off completely. 

3. Scratches 

Scratches Amount 

The total number of scratches that can be present within the frame 
at the same time. 

Scale 

The parameter sets the magnification of all scratches relative to the frame size. 

Size Balance 

Size Balance adjusts the ratio between large and small scratches. 

White-Black 

Depending on which stage of the film production the scratches appeared, 
they  may be dark or light. The ratio between them can be adjusted 
with the White-Black parameter. 

Scratches Enabled 

The Scratches Enabled checkbox turns scratches on or off completely. 
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4. Global Settings 

Total Amount 

You can use the Total Amount slider to decrease or increase the total amount 
of  all artifacts within the frame, with no need to reconfigure each type 
individually. 

Global Period 

The defect areas on film are irregular along its length. The Global Period 
parameter controls how often artifacts appear. The smaller the value, the more 
evenly the defects are distributed along the length of the roll. 

When Global Period = 1, the amount of dirt between neighboring frames will be 
almost the same. When Period is increased, the areas with the maximum and 
minimum amount of artifacts will be more extended. 

Global Opacity 

Global Opacity allows you to adjust the total transparency of the effect, to make 
it more or less noticeable. This parameter doesn’t affect the number of artifacts, 
but only their visual density. 

Global Chromaticity 

Dirt particles affect the light flow, and their transparency, thickness, distance 
from the film surface, depth of damage and other factors determine the affected 
emulsion layers and their exposure. 

When transparency is reduced, light artifacts visually take on a bluish hue, while 
dark artifacts, on the contrary, appear warmer. 

The Global Chromaticity parameter adjusts the overall saturation. When it is set 
to minimum, artifacts become pure black and white, regardless of their 
transparency. 

Related article: 

Dehancer Film Damage
→

https://blog.dehancer.com/articles/dehancer-film-damage/
https://blog.dehancer.com/articles/dehancer-film-damage/
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Vignette 

In lens design vignetting is usually considered a flaw. However, it is also 
a proven creative tool that allows for better focusing on a subject and adds extra 
depth. Also, in digital processing vignette with positive exposure values can be 
used to compensate for unwanted vignetting. 

Exposure 

Negative Exposure values result in dark vignette while positive values, 
respectively, produce the light vignette. 

Size 

This setting defines a size of the vignetting circle. 

Feather 

Feather controls the amount of blur applied to the vignette circle. 

Aspect Ratio 

This parameter affects the proportions of the vignette, allowing to make 
it elliptical (in both the X and Y directions). 

Center 

These fields specify the X and Y offset of a vignette relative to the center 
of  a  frame in  the range of  -1  to  +1 (from one edge to the other 
where 0 represents the center). 

Tip: Although the Vignette tool is located at the very bottom 
of  the  Dehancer settings, we recommend to adjust it  at  the  beginning 
of color grading since it affects the exposure and usually increases contrast 
between the edges and  a frame center, thus requiring additional 
adjustments of the exposure and contrast. 
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Film Breath 

Featured in: Dehancer Pro 

The film breath effect is an accidental change in exposure, contrast and color 
from frame to frame as the film moves. Caused by uneven emulsion coating 
or development, instability of a camera shutter and other deviations, film breath 
greatly affects the viewers’ experience in terms of ‘analogue feeling’. 

To mimic the Film Breath phenomenon, we implemented a special toolset. 

Film Breath Profiles 

The most characteristic ‘emulsion breath’ is represented by the profiles 
for  the  four major film formats. The smaller the format, the more obvious 
the changes from frame to frame. 

In order to change the parameters of any profile, you must first select the most 
suitable one and then switch to Custom mode. All the usual effect settings 
will be available to you, and the parameter values will match the last selected 
profile. 

Custom settings 

The Custom settings allow you to configure Film Breath as you like: 

Period 

Period determines the number of frames within which color, contrast 
and exposure varies. The larger this value is, the smoother these fluctuations 
are. With smaller values changes occur faster and are ‘jerkier’. 

Exposure, Tonal Contrast, Color 

The Exposure, Tonal Contrast and Color parameters determine the amplitude 
of  fluctuations. With greater values, the variations of the corresponding 
parameters will be more pronounced. 
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Impact 

Impact adjusts the overall effect. All fluctuations are reduced or increased 
altogether. 

Tip: Film Breath preview is demanding on playback FPS. For a precise 
setup, make sure that your clip is played smoothly to judge the effect. 
 
To optimise the playback, please, check: 
Performance Tips and realtime playback 

 

Related article: 

Film Breath and Gate Weave. Introduction to the new tools
→

https://blog.dehancer.com/articles/film-breath-and-gate-weave/
https://blog.dehancer.com/articles/film-breath-and-gate-weave/
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Gate Weave 

Featured in: Dehancer Pro  

Gate weave stands for mechanical swinging of a film strip while it is being pulled 
through a frame window in a film camera, projector or video coding device. 
It is often simulated intentionally to ‘breathe life’ into a digital cinema. 

Gate Weave Profiles 

The mechanical movement of the film as it is pulled through the frame window 
of a film camera, projector or video encoder (film scanner) is more evident for 
small film formats and less evident for large ones. The ‘jitter’ character 
is represented by the profiles of the four main formats. 

In order to change the parameters of any profile, you must first select the most 
suitable one and then switch to Custom mode. All the usual effect settings 
will be available to you, and the parameter values will match the last selected 
profile. 

Custom settings 

The Custom settings allow you to configure Gate Weave as you like: 

Period 

The Period parameter determines the number of frames within which 
frame  shifts occur. The larger this value is, the smoother the ‘bumps’ during 
playback are. With smaller Period mechanical shifts occur faster and ‘film’ yaws 
jerkier. 

Translation X, Translation Y 

The Translation X and Translation Y settings specify an amplitude of random 
shifts in a frame plane in conventional units. 

Rotation 

This parameter sets the maximum angle of random frame rotation in relative 
units. 
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Auto Zoom 

This option automatically zooms an image to compensate frame shifts brought 
in by the current Gate Weave settings to crop any black gaps left around a frame 
where a geometric transformation occurs. 

Impact 

Within the Gate Weave tool the Impact parameter adjusts the overall impact 
factor, not  the ‘opacity’ of the effect. When Impact is reduced, all shifts 
and geometric distortions in a frame are proportionally reduced. 

Tip 1: Film Breath preview is demanding on playback FPS. For a precise 
setup, make sure that your clip is played smoothly to judge the effect. 
 
To optimise the playback, please, check: 
Performance Tips and realtime playback 
 
Tip 2: If you are experiencing excessive loss of detail with Gate Weave, 
and  the  Film  Grain is enabled, it is possible to partially compensate 
the effect increasing the Film Resolution parameter. 

Related article: 

Film Breath and Gate Weave. Introduction to the new tools
→

https://blog.dehancer.com/articles/film-breath-and-gate-weave/
https://blog.dehancer.com/articles/film-breath-and-gate-weave/
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Overscan 

Featured in: Dehancer Pro 

Usually motion picture film is scanned with additional area for further 
processing. In this case, the scanning area may contain the interframe space, 
perforations, portions of the previous and next frame. 

Normally, scans are  cropped using the exposed area, but sometimes 
information outside the  film gate is intentionally included. This technique 
is called Overscan. 

Gate Type 

The type of film gate sets the film format and the type of camera. The following 
options are available: 

Super 8mm 1.33:1 
Super 8 motion picture film with aspect ratio of 1.33:1 (4:3) 

Standart 16mm 1.37:1 
16 mm motion picture film shot in standard aspect ratio of 1.37:1 

Super 16mm 1.66:1 
Super 16 mm motion picture film with a 1.66:1 aspect ratio 

Ultra 16mm 1.85:1 
16 mm motion picture film shot in aspect ratio of 1.85:1 

Super 35mm 1.37:1 
35 mm motion picture film shot in standard aspect ratio of 1.37:1 

Widescreen 35mm 1.85:1 
35 mm motion picture film shot in widescreen aspect ratio of 1.85:1 

Ultra Panavision 65mm 2.76:1 
65 mm motion picture film shot in Ultra Panavision aspect ratio of 2.76:1 

Tip: The 16:9 aspect ratio is not here, since it does not exist on  film. 
The closest film format is Widescreen 35mm 1.85:1 with a frame pitch of 
3 perforation holes (3 perf), and it is cropped to 16:9 with minimal loss. 



57

Gate Shape 

The shape of the film gate is determined by the specifics of a particular camera. 
The most common options are available: 

Neat Normal - standard frame with slightly rounded corners 

Neat Sharp - a frame with sharper corners with almost no rounding 

Neat Rounded - a frame with the corners rounded to a large radius 

OFF - Film Gate is disabled 

Perforation Mode 

The perforation type of the scanned film is represented by 3 options:  
Negative, Positive, OFF 

The negative scan is inverted and the backlit perforations become black. 
Positive films, on the other hand, do not need to be inverted and retain their 
original white perforations. At the postproduction stage, they can be filled with 
the film base color. This action is simulated by the OFF mode. 

Scale 

Image scaling (crop) after scanning. Varies from 0 to 100. 
When Scale = 100, the film gate is completely outside the frame. 

Gate Defocus 

The frame focus depends on the tightness of the film against the film gate, 
the  type of camera and its technical condition. In Dehancer you can control 
the degree of defocusing in the range from 0 to 100 conventional units. 

Exposure 

Depending on the backlight intensity and exposure during scanning, 
the Halation effect on the edges of the perforation may be visible to a greater 
or  lesser extent. The Exposure parameter sets the exposure of the ‘scan’ 
in  the  range from -2 Ev to +2 Ev, which allows you to make the perforation 
more or less pronounced. 
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Static Gate 

This option allows you to enable or disable dynamic variation of the film gate 
from frame to frame. 

By default, the film gate is static and does not change throughout the clip, 
which corresponds to Static Gate = ON. If Static Gate is disabled, film gates with 
slight variations in shape will be used for each frame. 

Flip 

Normally, the layout of the perforations and the gate is determined by the film 
format and the technical standard of the camera and scanner. 
However,  for  creative tasks, we have added a Flip option that mirrors 
the perforations and frame horizontally while keeping the image unchanged. 

Enabled 

This option allows you to completely enable or disable the Overscan tool. 

Notice: 
Since Overscan Tool contains a number of practical simplifications, 
it is appropriate to call it stylization rather than imitation. 
We  have  implemented the basic components for the most common 
formats. In the future, the tool will be improved by expanding 
the set of gates, formats and additional elements. 

 

Related article: 

Dehancer Overscan Tool
→

https://blog.dehancer.com/articles/dehancer-overscan-tool/
https://blog.dehancer.com/articles/dehancer-overscan-tool/
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Monitor 

False Color IRE, 16 zones 

False Color tool represents different luminance values by distinct color ‘zones’ 
which gives a clear view of the exposure levels. False Color is a popular method 
of a technical image control that provides a foolproof clipping and exposure 
monitoring, emphasises details that otherwise aren’t visible to the human eye 
and  reveals hidden textures. This tool is often useful for adjusting skin tone 
exposure and for clip matching. 

The single parameter is a checkbox which enables/disables the effect.  

Clipping Indication 

The Clipping Indication allows you to perfectly see the areas of  the  image 
with  minimum exposure in shadows (RGB 0-5, filled with blue) and with 
maximum exposure in highlights (RGB 250-255, filled with red).  
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Output 

The Total Impact slider is the single parameter in this group that controls 
the overall impact of all the effects engaged in Dehancer plugin. 

Tip: Total Impact is not equivalent to effect opacity as it properly reduces 
the impact of the geometric distortion effects such as Gate Weave. 
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LUT Generator 

Featured in: Dehancer Pro  

Since Dehancer is a resource-demanding tool that also requires a dedicated 
installation, in  some cases it is more convenient to export a grading look 
as a LUT file for further DIT on-stage or realtime dailies grading. 

Dehancer LUT incorporates the color and contrast attributes within the plugin 
and doesn’t include any other FX, adjustments nor color space 
transformations. It’s technically impossible since the plugin doesn’t even know 
what’s going on outside. 

The simplest approach is to use only the correction tools available in the plugin. 
In this case, the LUT generated with Dehancer contains all color-contrast 
characteristics of the look. 

Otherwise, you have to structurally divide your grading into several parts 
that can be technically exported as a LUT one by one. Then generate the LUT 
within Dehancer and temporarily replace the plugin instance with this LUT. 
This  approach technically allows exporting the complete look, including 
Dehancer and other corrections as a single LUT using your host’s native 
LUT export tools. 

LUT Size 

LUT Generator allows to export a color-contrast solution achieved in Dehancer 
as a LUT with two quality options: Small (17x17x17) and Normal (33x33x33). 

In most cases the small LUT is enough for DIT on-stage preview tasks. 
Also,  it  reduces the  processing load. If you encounter visible artefacts, 
try the Normal setting as a possible workaround. 

Disable Input Transform 

This option excludes the effect of Input settings from a generated LUT, 
thus allowing for using this LUT universally, with any source and color science. 
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Tip: Notice that an exported LUT doesn’t include the effects based 
on  geometric transformation or local corrections (including Film Grain, 
Halation, Bloom, Vignette, Film Breath and Gate Weave) and therefore 
cannot be used as a grading preset. Furthermore, the quality of a simple 
LUT may not be sufficient for demanding delivery. 
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Options 

License Info 

This button launches the Licence Info widget where you can view current 
activation status of the plugin and activate your License Key. 

Check Profiles 

Use this button to check and download the updated Camera and Film Profiles.

Related articles: 

F.A.Q.: Dehancer plugin and Profiles Update 
F.A.Q.: How to buy and activate the License?

→

https://blog.dehancer.com/faq/#19
https://blog.dehancer.com/faq/#31
https://blog.dehancer.com/faq/#19
https://blog.dehancer.com/faq/#31
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